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Expert Speaker

David Berman, R.G.D., FGDC

Topics (available publicly or at your location)

= Perfecting Your Web Strategy 2.0

= Management of Web Projects + Accessible PDF
= Effective Web Interface Design

= Design and Social Responsibility

Links and books:
http://www.davidberman.com/courses/web-accessibility#links

ﬁDavid Berman | David Berman
Iinkedin.com/in/bermandavid
twitter.com/davidberman

David Berman was recently named a high-level advisor to the United Nations on how design and
information technology can combine to help fulfill the Millennium Development Goals. He has over 25
years of experience in design and communication strategy. David hrings both graphic design and
information technology expertise to his strategy and communications projects. While training at the
University of Waterloo in computer science and at Carleton University in psychology and typography.
he became deeply involved with the student press, introducing microcomputers to the production of
student newspapers in Canada. David worked in the federal government as a computer systems analyst
before turning his hobby of graphic design into his career.

David is a consultant on common look and feel implementation for large Web sites and products, and
has worked on CLF projects for many large organizations including Statistics Canada, the National
Research Council, and IBM. He has been the project manager of numerous accessible Web projects and
has developed strategy and design for CRA, Health Canada, Canadian Heritage, Industry Canada,
CMHC, and the International Space Station ...as well as for many private sector and non-profit
organizations. He has worked extensively in adapting the printed word for electronic distribution,
including software interface development. David has advised governments in Australia, Canada, India,
and Norway on accessibility issues.

He served as the first elected president of the Association of Registered Graphic Designers of Ontario,
the world's first accredited graphic design organization, from 1997 to 1999. He drafted the association’s
constitution and Ruldes of Professional Conduct and authored Ontaric’s accreditation examination on
ethics and professional responsibility. In 1999, David was named a Fellow to the Society of Graphic
Designers of Canada. In 2001 he was elected national vice-president. In 2009, he was elected to a third
consecutive term to the executive hoard of the world body for communication design, Icograda.

David is an expert speaker and a national professional member of the Canadian Association of Public
Speakers, bringing him to over 25 countries within the past decade. Presently, he is Ethics Chair for the
graphic design profession in Canada and is a frequent international keynote speaker on the role of
communications professionals in creating a more socially responsible world. His recent book, Do Good
Design {Pearson/Peachpit/AIGA), published in four languages, puts accessibility in the framework of
how designers can create a world where no one is left behind.
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WCAG 2.0 Conformance requirements

Conformance Requirement 1: conformance level A, AA, AAA
Conformance Requirement 2: full pages
Conformance Requirement 3: complete processes

Conformance Requirement 4: only accessible-supported
ways of using technologies

Conformance Requirement 5: non-interference

conformance requirement 1 of 5
Conformance level

Conform to your stated level.

davidberman.com

WCAG 2 Conformance Levels: http://www.w3.0rg/TR/WCAG/#conformance

TSP PO FSTETTPPT: SVSPRRY PRSP
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conformance requirement 2 of 5
Full pages

Make the entire page
accessible, not just part of it.

conformance requirement 3 of 5
Complete processes

A page is not considered conformant if it part of a series
of pages making up a process in which any of the pages
falls short of conformance.

davidberman.com

WCAG 2 Conformance Levels: http://www.w3.org/TR/WCAG/#conformance

B L G R A ST
, sim i
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March 2012

conformance requirement 4 of 5
Only accessibility-supported ways

Unlike WCAG 1.0 which was all about HTML, WCAG 2.0
allows for formats not previously considered accessible
alone, such as Flash, Silverlight, or PDF...

...but you need to be just as careful to make these
formats accessible enough to comply.

For example, if PDF is the only way you are publishing a
given piece of content, it must conform to WCAG 2.0,
preferably using the draft guidelines for publishing in
PDF.

Which brings us to accessible PDF.

davidberman.com

Free online PDF conversion tools:
http://www.adobe.com/products/acrobat/access_onlinetools.html

PDF and accessihility: htip://www.adobe.com/enterprise/accessibility/main.html

Creating Accessible Adobe PDF Files:
http://www.adobe.com/enterprise/accessibility/pdfs/acro6_pg_ue.pdf

aDesigner (Flash and Flex accessibility checker):
http://blogs.adobe.com/accessihility/2009/06/evaluating_flash_and_flex_cont.html

Sample Accessibility Notice (http://www.ths-sct.gc.ca/clf>-nsiz/th-bo/an-aa-eng.asp):

If the following [information, content, document, application, form, interactive questionnaire,
animation, multimedia presentation, etc.] is not accessible to you, please contact [name, email,
telephone number, facsimile number, teletype number, mailing address or other appropriate contact
information] for [assistance, explanations, to obtain other formats such as regular print, large print,
Braille, audio cassette or other appropriate format

Sample Accessibility Notice on the “Help” Page (http://www.tbs-sct.gc.ca/clf2-nsiz/th-bo/hpan-paaa-
eng.aspl:

While every reasonable effort has beent made to ensure the accessibility of this site, some content or
services found here might be inaccessible to some visitors. In those circumstances, the contact
information for someone who can assist you has been provided.

59 © 2000-2012 DavidBerman.com
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“Each PDF page is a painting” a
- Duff Johnson, chair PDF/UA committee

How will we get to a workflow and quality assurance
regimen will bridges the gap between the WCAG 2.0
ideal and the history that brought PDF to be the world’s
preferred portable document format for eyes to read and
make it also the favorite for machines to read?

“Camelot?”

picture darned faithful?

davidberman.com

The Lady of Shalott by JW Waterhouse (1849-1917) “Camelot” by John Warnock, 1991

Photo of John Warnock by self, GNU license
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A brief history of PDF

“PDF” is a PostScript-based file format 139 g
= free since 2001 e e e e
* PDF 1.7: open, published ISO standard
“Adobe Reader”

* a free application and plug-in
» called “Acrobat Reader” up to v. 5 e
“Acrobat” is an application o

= “Acrobat Standard” or “Acrobat
Professional”

“Distiller” is a program (was printer driver)

“Adobe PDF” is a printer driver (formerly ""’"‘:"_".'v_‘v“'.'_":‘__":'"‘fw
“PDFWriter”)

davidberman.com

Ford Equity Research

Mormingstar Equity ew repan
Research St

PDF versions:

1993: Acrobat 1.0 makes PDF 1.0
1994: Acrobat 2.0 makes PDF 1.1 or below
1996: Acrobat 3.x makes PDF 1.2 (the minimum WCAG-recognized) or below

2000: Acrobat 4.x makes PDF 1.3 (PDF/X) (the first PDF with logical structure features)
or below

2001: Acrobat 5.x makes PDF 1.4 (Tagged PDF) or helow

2003: Acrobat 6.x makes PDF 1.5 or below (first inclusion of XFA and usage rights
signatures)

2005: Acrobat 7.x makes PDF 1.6 or below (first support for interactive 3D documents)
2006: Acrobat 8.x makes PDF 1.7

2008: Acrobat 9.0 makes PDF 1.7, Adobe Extension Level 3 (and PDF 1.7 is published
as [S0O-32001)

2009: Acrobat 9.1 makes PDF 1.7, Adobe Extension Level 5
Today: Acrobat X (10) makes PDF 1.7 or below
Future: PDF 2.0 (ISO 32000-2)

PDF subsets:

2001: PDF/X: PDF for Exchange

2005: PDF/A: PDF for Archive

2008: PDF/E: PDF for Engineering

2008: PDF/H: PDF for Healthcare (not a standard or proposed standard)

2010: PDF/VT: PDF for exchange of variable data and transactional (VT) printing
2011: PDF/UA: PDF for Universal Access

March 2012 61 © 2000-2012 DavidBerman.com
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davidberman.com

Accessible PDF E

Current PDF format supports accessibility, but it takes
special effort to get it right, as most Export commands
unfortunately still fall short of yielding accessible PDF.

* PDF can have accessibility features similar to HTML
tags, text equivalents, captions, audio descriptions

“Tagged” PDF files include info for a tagged “view” as
well as the physical view (typical display, printout)

= screen readers can read tagged PDF, thus delivering
content as intended, non-visually, in the correct order

= tagged PDF can be re-flowed and magnified

PDF/UA: a PDF spec specifically for access (I1SO 14289)

For more expertise on truly accessible PDF: T-Base Communications, Ottawa

PDF Accessihility Checker (PAC): htip://www.access-for-all.ch/en/pdf-
werkstatt/pdf-accessibility-checker-pac.html

Service you can plug into your CMS to live Web site monitoring by a third-party
that will ensure all your PDFs are 100% WCAG2 Level AA-compliant: APP

March 2012
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Tagged PDF: Tags pane

View > Show/Hide> Navigation Panes> Tags .

Construct _____|HTML________|PDFtag |

Heading <hl> to <h6> <H1> to <H6>
Paragraph <p> <P>
List <ul>, <ol> <L>

Table, table cells <table>, <th, <tr>, <Table>,
<td> <TH>,<TR>,<TD>

Images <img> <Figure>, Artifact

Acrobat Tips

= turn on Highlight Content (and use its sibling, the Find
Tag From Selection command)

= Accessibility> Add Tags To Document

davidberman.com

....... e
""" i e 4.
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We need excellently tagged PDF

Tour:
-untagged file
-generate tagged file from InDesign
‘tagged file:
- Orders tab
- Tags tab
- Full Check
- look at structure samples
In InDesign show the Structures tab
- Add Untagged Items (right click)
Map Styles to Tag (right click)
Show the Show Text Snippets (on Structures pull-down)
Edit | Edit in Story Editor and show the P tags you mapped
- Show changing a Figure to an Artifact
- Show adding a new alt attribute to a Figure

E
8
9
=
g
=
5
2
=
=
H
S
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- PDF testing/remediation tools Pa

Acrobat Pro’s Accessibility Full Check: commenting,
option levels, repair hints ...but only guesses at intent
Third party tools (e.g. NetCentric Common Look PDF
and Common Look Clarity)

PDF Refer

fifth edition

davidberman.com

Testing tools specifically for accessible PDF:

Adobe Acrobat Pro

Commonlook Section 508 for Acrobat

PAC (PDF Accessibility Checker) from <<Access for all>> Foundation

PDF User Agents:

Adobe Acrobat Pro

Adobe Reader (standalone and browser plug-ins)
Kurzweil 3000 text to speech

Assistive Technology Support for PDF:

JAWS (4.x and up) screen reader

MAGic 11 screen magnifier

NVDA

Supernova Access Suite

System Access To Go

VoiceOver (MacOS 10.6 and up, i0S for iPhone and iPad)
Window-Eyes (4.2 and up)

ZoomText
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PDF testing: site-wide analysis

tCentric Enterprise Compkance Management Framework

PDF !

MetCent
Active Report

Pt s
s g
wF [Tagged Camrupt Prstactad Ovcament Comre| ot (1 P
Pages rigna Lk

E
8
g
=
g
=
5

2

b
=
H

S

Testing tools specifically for accessible PDF:

Adobe Acrobat Pro

Commonlook Section 508 for Acrobat

PAC (PDF Accessibility Checker) from <<Access for all>> Foundation

PDF User Agents:

Adobe Acrohat Pro

Adobe Reader (standalone and browser plug-ins)
Kurzweil 3000 text to speech

Assistive Technology Support for PDF:

JAWS (4.x and up) screen reader

MAGic 11 screen magnifier

NVDA

Supernova Access Suite

System Access To Go

VoiceOver (MacOS 10.6 and up, iOS for iPhone and iPad)
Window-Eyes (4.2 and up)

ZoomText

66

© 2000-2012 DavidBerman.com



PHA and T-Base present "Accessible PDF by Design: WCAG 2.0"

23 techniques to Accessible PDF

The WCAG 2.0 rules apply equally to PDF [

For simple documents, fewer concerns:
Alt attributes
Hide decorative images
Bookmarks (multiple ways)
Reading order (meaningful sequence)
Machine-readable text
Metadata (e.g. Page Title)

. it gets trickier when you have forms, tables, heading
Ievels lists, labels, headers, footers, page numbers,
abbreviations, and language changes.

davidberman.com

Wi3C's PDF Techniques for WCAG 2.0:
http://www.w3.0rg/WAI/GL/WCAG20-TECHS/pdf.html

FRREPPIPES: URRPRTRIPRCS FNUPNTRINIGS VRTINS (NPT NVPPPRPITR (ORI SRS
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First steps to Accessible PDF

s Form Took Advnced Plugins Windew Help

£ & ® s -

davidberman.com

Assessing PDF files for accessibility:
http://www.adobe.com/enterprise/accessibility/popup _assess_pdfs.html

Creating accessible PDF files:
http://www.adobe.com/enterprise/accessibility/popup_create pdfs.html

Guide to the essentials of creating accessible PDFs with Microsoft Word and
Acrobat Professional 8:
http://www.bbc.co.uk/guidelines/futuremedia/accessibility/bbc_accessible_pd
f_master17.pdf

PDF and WCAG 2.0 Webinar:
https://admin.adobe.acrobat.com/_a295153/p89681357/

Using accessibility features with Acrobat:
http://www.adobe.com/enterprise/accessibility/popup_acr8_accessibility.html
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Accessible PDF: fillable

| 47740001 (SECURED, - Adobe Acrobat Fro Bxended - e

"’EK Edt View Document Comments Forms Tooks Advasced Plugdns Window Hep
!

" ) b 1 /5 | Ih

davidberman.com

Adobe’s WCAG2 techniques for PDF:
http://blogs.adobe.com/accessibility/2012/01/wcag-2-0-techniques-for-pdf.html

Adobe’s PDF Reference (fifth edition, for Version 1.6):
http://partners.adobe.com/public/developer/en/pdf/PDFReference16.pdf

[Warning! 1236 pages!|
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Sustainable PDF: go to the source E

Whenever possible, build accessibility into the
source files (better yet, templates!) that the tagged
PDF originate from, so you’'ll automatically get
accessible attributes in current (or future) versions
of exports to PDF ...and avoid repeating repairs!

Microsoft Word (2010 preferred)

Microsoft Powerpoint

By Microsoft Excel (2010 preferred)

Adobe InDesign (CS5.5 preferred)

davidberman.com

Adobe Acrobat Pro (X preferred) with Livecycle Designer

Tagged PDF Authoring tools that provide accessibility support:

Adobe Acrobat’s PDFMaker (part of Adobe Acrobat that adds macros to
Microsoft Office, AutoCAD, Lotus Notes...)

Adobe Framemaker

Adobe InDesign

Adobe LiveCycle Designer (in Acrobat Pro, or standalone)
LibreOffice

Lotus Symphony Documents

Microsoft Word

NetCentric CommonLook (PDF Accessibility Wizard) for Microsoft Office (nee
PAW)

OpenOffice.org Writer
WordPerfect Office
Xenos Access for Accessible Statements

March 2012 70 © 2000-2012 DavidBerman.com
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Microsoft Word for Windows m

Word 2000-2003: with Acrobat and Acrobat add-in
Word 2007: either Acrobat or Microsoft PDF add-in

Word 2010: 32-bit alone or 32-bit with Adobe X add-in
(PDFMaker Save As) on a 32-bit or a 64-bit Windows

Word 2010 Accessibility Checker is like a spell check:

Microsoft Word 2010> File> Info> Check For Issues>
Check Accessibility ... errors, warnings, tips

davidberman.com

Unhappy news dept.: Word for Mac 2004 and 2008 has no way of adding alt text.

Adobe’s Accessible PDF from Microsoft Word (2007):
http://www.adobe.com/accessibility/products/acrobat/pdf/ Ag-accessible-pdf-
from-word.pdf

ST TSHPANRIPPRIHSS: FONRIPSFP PV SRR DR
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Adobe InDesign/Acrobat workflow

In InDesign CS5.5 (including tags subset)...
assign Alt text to images
Map Styles to Tags
anchor images in text flow
define content order in Articles panel

55 !

use Bookmarks/TOC/Hyperlinks/Cross-references

add file metadata

export (Interactive, Create Tagged PDF, Buttons & Media: Include All)
..leaving only an Action wizard to run in Acrobat Pro:

davidberman.com

run Accessibility Check

“Preparing InDesign Files for Accessibility™:

Pages tab> Page Properties> Tab Order=Use Doc. Structure
File> Document Properties> Advanced> Language —"a

http://tv.adobe.com/watch/accessibility-adobe/preparing-indesign-files-for-

accessibility/

Adobe Acrobat X Action Wizard for Accessible PDF:

http://www.adobe.com/accessibility/products/indesign/AcrobatXActionWizard

forPDFsCreatedwithInDesignCSs.5.html

March 2012 72
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conformance requirement 5 of 5
Non-interference

If technologies are present that are not accessibility
supported, then must not block the ability of the users to
access the technologies on the page that supply the
content accessibly. The page overall has to work:

1. when the non-accessible technology is off, and

2. when the non-accessible technology is turned on, and
3. when the non-accessible technology is not supported
by the browser.

davidberman.com

WCAG 2 Conformance Levels: hitp://www.w3,0rg/TR/WCAG/#conformance
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conformance requirement 5 of 5
Non-interference: specific criteria

Some success criteria apply to the page content as a
whole. They therefore must apply to content that is
using the non-accessible technology as well:

1.4.2 Audio Control
2.1.2 No Keyboard Trap
2.3.1 Three Flashes
2.2.2 Pause, Stop, Hide

davidberman.com

WCAG 2 Conformance Levels: http://www.w3,0rg/TR/WCAG/#conformance
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Testing tools suggested by W3C

W3C CSS Validation service (free service that
confirms CSS conform to W3C recommendations)

W3C Markup Validation service (confirms HTML and
XHTML conform to W3C and other standards)

W3C Link checker (confirms that public links work)
W3C RSS feed checker (confirms RSS code works)
Colour Contrast Check (free interactive tool)

The HTML Tidy cleanup utility

...and more

davidberman.com

W3C HTML Test Suite for WCAG 2.0;
http://www.w3.0rg/WAI/GL/WCAG20/tests/

W3C CSS Validation service; http://jigsaw.w3.org/css-validator
W3C Markup Validation: http://validator.w3.org

W3C Link checker: http://validator.w3.org/checklink

W3C RSS feed checker: http://validator.w3.org/feed

HTMLTidy: htip://www.w3.0rg/People/Raggett/tidy

bbb e b
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Favourite testing tools

v’ Clear Language: “Fog Index”

v" Screen reader emulators

v" Browser compatibility testing

v’ Screen size testing

v" Colour deficiency simulations

v" Toolbars for browsers and editors

v Accessibility analyzers

v’ Testing suites (e.g. HP Quality Center, QuickTest Pro)

davidberman.com

Browser compatibility testing: http://www.anyhrowser.com/siteviewer.html
and Adobe Browserlah: hitp://browserlab.adobe.com
Browser emulator for really early browsers: http://www.dejavu.org

Fangs (Firefox extension) screen reader emulation: https://addons.mozilla.org/en-
US/firefox/addon/fangs-screen-reader-emulator

Screen size testing: http://www.anybrowser.com/ScreenSizeTest.html
Colour deficiency simulator (and image corrector): http://www.vischeck.com

Colour deficiency simulator (iPad/iPhone):
http://www.brailleinstitute.org/MobileApps.aspx

Deque Worldspace Single Page accessibility analyzer:
http://wsspg.dequecloud.com/worldspace/wsservice/eval/checkCompliance.jsp

Web Accessibility Toolbar for IE: http://www.paciellogroup.com/resources/wat-ie-
about.html

Web Developer Toolbar (Chrome and Firefox extensions):
htip://chrispederick.com/work/web-developer

WAVE Toolbar for Firefox: hitp://wave.webaim.org/toolbar

WAVE for Dreamweaver: http://wave/webaim.org/blog/wave-dreamweaver-extension
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Testing tools: Deque

v Deque Single Page Analysis:
slow, thorough, does offline
pages and PDF too!

Patential Violations Summary

v" FireEyes Worldspace Firefox :
plug-in (needs Firebug) '

Ire

worldspace

readable and understandable

E
8
g
=
g
=
5

2

b
=
H

S

Deque Worldspace Single Page accessibility analyser:
http://wsspg.dequecloud.com/worldspace/wsservice/eval/checkComplian
ce.jsp

Deque FireEyes Worldspace Firefox plug-in:
http://worldspace.deque.com/FireEyes

Fog Index: {adapted courtesy tech-head.com)

This simple procedure produces a Fog [ndex score: a lower score indicates easier-to-read content.

1.  Count all the words in 8 typical sentences, then divide by 8 to calculate the average words per
sentence. (Count clearly independent clauses as separate sentences, Example: "By and by Tran; 1
jumped; I hid." is three sentences.)

2. Calculate the percentage of words that are three syllables or more. (Don't count proper names. Don't
count verbs that make three syllahles by adding -es or -ed.)

3.  Sum these two figures. Example: if your average number of words a sentence is 15, and the percentage
of words three syllables or more is 12%, you would add 15 and 12 toc get 27.

4. Multiply that sum by 0.4. The resulting number is vour Fog Index, a rough measure of how many years
of schooling it would take to understand what you have written. In our example, multiplying 27 by 0.4
equals a Fog Index of 10.8.

Interpretation: The Bible, Shakespeare, Mark Twain, and TV Guide all have Fog Indexes of around 6. Time,

Newsweek, and The Wall Street Journal average around 11. [f your index is 13 or higher, you certainly risl

losing most of your audience in the fog.
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*  Testing/fixing tools: NetCentric

& CommonlLook

CommonLook Office / PAW (Word to PDF)
CommonLook PDF (for PDF files) ... Light + Pro
CommonLook Clarity (server-wide PDF assessment)

Active Report

davidberman.com
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Testing/fixing tools: NetCentric
CommonLook Office (Word, Powerpoint)

CommonLook yields an .xml file in the same folder as
the Word document (CommonLook Office 2 won't
require the xml), helpful for your next export

CommonLook Office 2 (coming later in 2012) will
support PowerPoint, will eliminate the need for .xml
file

= CommonLook

davidberman.com

ereren S
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Real-world testing is critical to
accessibility and usability

Test to ensure the design works for real users

Whao: Group Who: One person at a time

What: Get a sample of users’ What: Show something and ask
opinions and abstract feelings | them what it is, or to try to
about concept complete a task

When: Before design When: After overall design, each
page type, each template
Frequent testing trumps statistical relevance

Test in context: their phone ringing, their equipment,
their workflow

“If we had asked the public what they wanted, they would have said ‘faster
horses”.” — Henry Ford (1863-1947)

The Hawthorne effect: the tendency for people to act differently when they
know someone’s watching.

David’s fave books about Usability Testing:
Don’t Make Me Think by Steve Krug, Que Publishing, 2000, ISBN: 0-7897-2310-7

Handbook of Usability Testing by Jeffrey Rubin, John Wiley & Sons, 1994, ISBN:
0-471-59403-2

...also, to learn more about testing, consider our course on information/interface
design,
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Global thinking, starting at home.

W. Edwards Deming
(1900-1993)

davidberman.com

Find a list of hypertext links and books cited in this learning guide at:
http://www.davidberman.com/courses/web-accessihility#links .
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Read the first 40 pages of Do Good Design
free at Google Books:
davidberman.com/dogoodgooglebook

Participants are entitled to a 30%
discount on a paper or e-book edition of
Do Good Design from peachpit.com, by
quoting this Discount Code:

DO-GOOD

(enter the code upon checkout at the
peachpit.com store)
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